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format audio and AVI format video files. Select any of the topics listed below for more information on how 
to use the viewer.
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Glossary
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Following are common computer-related terms with which you may be unfamiliar and which are not 
defined elsewhere in this file.

ASCII
This is a text-only format which is able to be read by most text editors and other software applications. 
ASCII format text does not contain controls for setting fonts, indents or other page layout features. Some 
specialized characters cannot be directly saved or displayed as ASCII format text.

.AVI
This is a file format for animation or video clips.

BMP
This type of file is used to store bitmap (paint type) pictures.

Bytes
Computers store and process information as a series of on (one or white) and off (zero or black) 
instructions. A series of eight on or off instructions is known as a byte (or an ASCII character). The 
number of bytes used in a file determines how much memory and disk storage space is required by that 
file.

Clipboard
When you use the CUT or COPY commands (in the Edit Menu), the currently selected file or text is 
written to a temporary storage location, known as the Clipboard. From the Clipboard, the file or text may 
be PASTED to a different location or imported to another application. See your Windows documentation 
for more information regarding the Windows Clipboard.

Directory/Subdirectory
The files on your disks are usually organized into groups known as directories. Each directory usually 
contains files related to each other. Directories may also contain other directories which are called sub-
directories. The directory which contains a sub-directory is known as a root directory.

Drop-down Menu
When you click on items in the row of categories displayed just below the NeoSoft Viewer title bar, a list of 
commands and functions will be displayed. You may click on a command or function on these lists 
(menus) to enable it. You may also use the ALT key in combination with the underlined letter in the 
category title to drop down the list of selections.

.EXE, .COM, .BAT or .PIF files
These letters following a file's name indicate that the file is used to start a software program.

HEX
This is a more convenient way to represent the    ones and zeros which make up each byte of information 
in a file. Since each byte is made up of a series of eight ones and zeros, it saves space and is easier to 
write bytes using the Hexadecimal (base 16) format. Hex represents each string of eight characters with a 
digit ranging from 0-9, plus the letters A-F (e.g., Hex "F" equals 15 in normal decimal notation). Since Hex 
is written using the base-16 system, each digit to the left represents    a multiple of 16 times the digit (e.g., 
Hex "1E" = 30, and Hex FF = 255). The viewer displays both the Hex value, with the ASCII text for the 



values in the column to the right.

.ICO
These letters following a file's name indicate the file contains a Windows-type icon image.

Icon
An icon is a small picture representing a commonly used function. Simply click on an icon to activate that 
function.

Line
When displaying a file using either Standard or Hex views, the file is listed out with the file contents 
arranged in lines of text. 

Path
A file's location on your system is called its "Path." The path consists of the disk drive letter, plus the 
directories and subdirectories needed to go from the disk's root directory to the subdirectory containing 
the file (e.g., a file on the C drive which is contained in the CANDIES subdirectory of the COOKBOOK 
directory would have a path of C:\COOKBOOK\CANDIES\.

.PCX
This is a common image file format for paint-type and scanned pictures.

Print device
The print device is determined by the way you have configured Windows. If you wish to print to a different 
device, you should consult your Windows documentation for instructions on how to add or change the 
current print device.

String
A string is a sequence of characters (e.g., a sentence is simply a string    of characters).

Text Editor
A text editor, for the purposes of this application, can be NotePad or any word processor which is capable 
of editing and saving files in plain ASCII text format.

.WAV
This is a common Windows-based audio file format.

Wildcard characters
These characters are used as placeholders during searches. The asterisk (*) character and the question 
mark (?) are used as wildcard characters. The ? acts as a placeholder for a single character, while the * 
acts as a placeholder for all characters in that position and following. E.g., using the string NO?E.T*    to 
search for    file names would find all files which began with NO and which had any character in the third 
position and had an E in the fourth position, and which ended with the letters .T plus any characters 
following the T (such as NOTE.TXT, NOME.TOT or NODE.TNT).

.WMF
These letters following a files name indicate that the file contains a Windows Metafile type graphic.

Zip or Lzh formats
These file formats are produced by utilities which take one or more files and produce a new "compressed" 
file which occupies less disk space. Materials sent from BBS's and over the Internet are often 
compressed using these formats to reduce the time they take to send over phone lines. NeoSoft Viewer 
can view the contents of these files and extract/decompress them to your disk.



File Search Name and Location

You may search for files having certain names or which reside on certain disks or directories, either alone 
or in combination with other parameters.

Use the File Name/Mask    field to specify a filename, or use wild card characters to search for a range of 
files having common characters (e.g., use the * wildcard in the string "S*.EXE" to find all files which begin 
with "S" and end in ".EXE"). Using "*.*" will search for all files. You may specify more than one file name 
mask in this field by typing them into this field, separating each with a space.

Use the Location    field to specify a certain disk or directory to search. Click on the arrow button to the 
right of the field to select from the drives and directories available on your system.

Checking the Include Subdirectories    box will also search any directories contained under the drive 
and/or directory specified in the Location    field. Click on the Search    button to locate files which match 
the filename, drive/directory and any other features you specified.

To select other search parameters in addition to Name & Location,    click on the tabs at the bottom of the 
dialog before selecting the Search    button.

Use the Clear    button to disable all previously entered search parameters. Selecting the Close    button 
will return you to the main viewer without performing a search.



File Search Date

You may search for files which were created on a certain date, or between a range of dates, either alone 
or in combination with other parameters.

Click on the Search All files    button to ignore file dates. Enable the Limit the Search    button to search 
for only files created or last modified on the date(s) you specify.

Clicking on the Between    field will only look for files created or last modified between the dates you enter 
into the fields to the right. Clicking on either of the During the Previous    buttons will allow you to limit the 
search to files created or last modified during the amount of time you specify prior to the computer's 
current date. Click on the Search    button to locate files which match both the date and any other features 
you specified.

To select other search parameters in addition to Date,    click on the tabs at the bottom of the dialog 
before selecting the Search    button.

Use the Clear    button to disable all previously entered search parameters. Selecting the Close    button 
will return you to the main viewer without performing a search.



File Search Time

You may search for files created or last modified during certain hours, either alone or in combination with 
other parameters.

Click on the Search All files    button to ignore the file time stamp. Enable the Limit the Search    button 
to search for only files created or last modified during the times you specify.

Checking the Between    box will only look for files created or last modified during the time period you 
specify. Type the start of the time period in the field at the left and the end of the time period in the field at 
the right. Use the During the Previous    field if you wish to look only for files created or last modified 
during a certain number of hours prior to the current time on the computer's clock. Click on the Search    
button to locate files which match both the time and any other features you specified.

To select other search parameters in addition to Time,    click on the tabs at the bottom of the dialog 
before selecting the Search    button.

Use the Clear    button to disable all previously entered search parameters. Selecting the Close    button 
will return you to the main viewer without performing a search.



File Search Size

You may search for files of a specified size or range of sizes, either alone or in combination with other 
parameters.

Click on the Search All files    button to ignore file size. Enable the Limit the Search    button to search 
for only files matching the specified size parameter.

Use the Bytes      field to specify the size (in bytes) for the files to locate. Use the field to the left of the Bytes 
filed to specify whether to only find files which are equal to    the number of bytes specified, greater than    
the number of bytes specified, less than    the number of bytes specified, or between    the number of 
bytes specified. Click on the Search    button to locate files which match both the file size and any other 
features you specified.

To select other search parameters in addition to Size,    click on the tabs at the bottom of the dialog before 
selecting the Search    button.

Use the Clear    button to disable all previously entered search parameters. Selecting the Close    button 
will return you to the main viewer without performing a search.



File Search Contents

You may search for files containing certain text, either alone or in combination with other parameters.

Click on the Search All files    button to ignore file contents. Enable the Limit the Search    button to 
search for only files containing the text string which you type in the space provided.

Checking the Match Case    box will only look for files in which the text appears using the same UPPER 
and lower case capitalization you used when entering the text string. Click on the Search    button to 
locate files which contain both the text and any other features you specified.

To select other search parameters in addition to Contents,    click on the tabs at the bottom of the dialog 
before selecting the Search    button.

Use the Clear    button to disable all previously entered search parameters. Selecting the Close    button 
will return you to the main viewer without performing a search.



File Search Results
This dialog displays the result of the Search/File Search function. You may click on the names of files 
found during the search to preview their contents in either Standard or Hex mode. The Show File Details  
option allows you view file size, date and other information. You may click on the Open    button to load 
the file into the main viewing area, or click on the Close    button to return to the main viewing area 
without loading a file.



Preferences Font/Color
Use this page of the Set Preferences function to select the font style and color used to view files in the 
main viewer.

Use the Screen Element    field to select the type of text which you would like to change.

Choose foreground colors from the Color    field using the left    mouse button. Select the background 
color using the right    mouse button.

Use the Set Font    button to change the font used to view files in the main viewer.

If you wish to set other preferences (Directories, or Miscellaneous settings), click on the corresponding 
tabs at the bottom of the dialog. Use the OK    button to return to the main viewer and begin using the 
changes you have made, or use the Cancel    button to return to the main viewer without changing 
anything.



Preferences Misc
Use this page of the Set Preferences    command to determine how various functions operate.

You may select from the standard Windows Style    file selector, or from the enhanced NeoSoft  Style    file 
selector for use when opening files, etc.

Use the Tab Size    field to specify the number of spaces to use when a tab character is encountered when 
viewing a file.

Enabling Show Image Files in Native Format    will place an option on the viewer screen which allows 
some bitmap image file formats to be displayed as pictures. Similarly, enabling the Show Archive File 
Contents    and Show Media File Contents    will place options on the viewer to show the contents of 
compressed files or to play animation or sound files when these are detected.

The Allow Launching of EXE, COM, BAT and PIF Files    checkbox allows you to enable/disable the 
Run    option under the File menu. Enabling the Allow Viewing of System/Hidden Files    checkbox lets 
you load normally unseen files having System or Hidden attributes into the viewer. Finally, you may 
increase the display speed of some larger files by using the Don't Calculate Length of Files > 500K    
function.

If you wish to set other preferences (Font/Colors or Directories), click on the corresponding tabs at the 
bottom of the dialog. Use the OK    button to begin using the changes you have made, or use the Cancel  
button to return to the main viewer without changing anything.



File Selector Browser

The Select a File    browser aids you when locating files to view or compare.

At the top of the dialog is the Location    field, which you may use to specify the path to search. 
Alternatively, you may scroll through the directories and files shown in the File    window (see below) 
which is situated just below the Location    field.

To the right of the Location    field are three icons. Clicking the icon on the left will toggle between placing 
the drives and directories at the top and bottom of the list of files displayed in the File    window. The other 
two icons switch between horizontal and vertical orientation for the File    and Preview    windows.

In the File    window, you may double click on a drive letter    to change to that drive, or double click on a 
directory folder    to open that directory.

Double click on the folder pointing left (followed by two dots) to go back one level in the directory tree.

Double clicking on the folder which is followed by a backslash (\) will bring you to the root directory of 
the current drive.

Clicking on a filename will select that file and load it into the Preview    box (when Show Preview  is 
enabled). When the desired file is located, use the OK    button to load that file into the main 
viewer. The main viewer can display several files and previews at the same time.

If you wish to see the size, date and other information regarding the files displayed in the File    
window, enable the Show File Details    check box at the bottom of the dialog.

If you know a file's name, you may type it in the File Name    field to bring it into the Preview window. If 
you know a part of the file's name, you may use wildcard characters in the File Type    field. If you wish to 
search through the entire drive for a File Name,    enable the Search Entire Drive    function at the bottom 
of the dialog. You may also limit your file list by entering multiple file types separated by spaces (e.g., 
*.BAT, *.EXE, *.COM).

Use the Cancel    button to abort the Open File    function.



Directory Selector

Use this feature to locate drives and directories to search. If you know the drive/directory location, you 
may type it in the Location    field at the top of the dialog.

To the right of the Location    field is an icon which is used to toggle between placing the list of drives at 
the top and bottom of the list of directories/subdirectories displayed in the window below.

In the Drive/Directory    window, you may click on a drive letter    to change to that drive, or click on a 
directory folder    to open that directory.

Click on the folder pointing left (followed by two dots) to go back one level in the directory tree.

Clicking on the folder which is followed by a backslash (\) will bring you to the root directory of the 
current drive.

Select a drive and/or directory by clicking on that drive/directory. The drive/directory will appear in the 
Location    field at the top of the dialog. Click on the OK  button to select the drive/directory location.

Use the Cancel    button to abort the search for Location .



Print

The Print  dialog allows you to send the contents of the file being viewed to the print device installed 
in Windows.

The Print What    header gives the currently loaded file's name and shows the Windows print 
device and port to which the file will be sent.

Margins  allows you to adjust the unprinted space around the edge of the paper. Note that many 
printers will not print all the way to the paper edge, and that you may have to increase the margin 
area to avoid cutting off portions of your text. You may specify measurements in increments of 
either Inches    or Centimeters    by clicking on the radio buttons on the right side of the dialog. If 
the file you are printing is an image, the margins are not available and the image will be centered 
on the page.

Header/Footer    allows you to print a line of text at the top and/or the bottom of each sheet 
printed. Use the "&f" code to automatically insert the filename in either the header or footer. You 
may also use the "&p" code to insert page numbers in either the header or footer text. "&d" will 
insert today's date, and "&t" will insert the current time. If you wish to print the "&" character in the 
header or footer, use "&&".

Other printing Options    allow you to print only a portion of the text which you've highlighted, let you 
print long lines wrapped to fit onto the paper size used in your printer, and let you send multiple 
copies to the printer.

Use the Setup    button to change the orientation, paper source bin or other Windows print 
information. The Print    button begins the printing process, while the Cancel    button returns you 
to the Viewer without printing.



Find

The Find function allows you to specify a string of text to locate within the file currently selected in the 
main viewer.

Type the text to locate in the Find What      field. If you wish to only locate text which uses UPPER and 
lower case capitalization in the same places as you entered, enable the Match Case    check box. If you 
have more than one file loaded into the viewer and wish to search all these files, enable the Search All 
Open Files    check box.

The Direction    control allows you to specify whether to search through the file Up    (backward) or Down  
(forward).

The Origin    control lets you start the search either from the Cursor    position, or from the Top  of the file.

Click on the Find    button to begin searching for the text. You will be returned to the main viewer with the 
text string located within the file. Clicking on Cancel    will abort the search process and return you to the 
main viewer.

To find subsequent occurances of the same text located using Find , use the Find Next      command (or 
use the F3 key) to continue the search.



GoTo Line

Use this function to go to a line within the file. Type in the line number to which to jump (note that the 
default number is the line on which the cursor is currently located). Press OK    to jump to the specified 
line, or press Cancel    to return to the main viewer without going to a new location.

The F4    key also may be used to invoke the GoTo Line function.



Registration Screen

If you are running a 30-day evaluation copy of this program, each time you load the program or when you 
select the Help/About menu function, you will be given an opportunity to obtain the current registered 
version, documentation, technical support and upgrade opportunities. Select the Evaluate button to 
continue to use the program on a trial basis (up to 30 days), or select the Register button to enter the 
serial number you received when you purchased the package.

If you wish to order the program, you may either call the telephone number listed, or print out the order 
form (using the button provided) and send it via mail or fax to NeoSoft Corp. Payment may be made by 
either check or money order (payable in U.S. Dollars), by major credit card (VISA, MasterCard, Discover 
or American Express), or by institutional purchase order (on approved credit).

Select the Cancel    button if you prefer to continue to evaluate the product.

Once you have purchased the product, you will receive the latest version of the product, plus a number to 
type into the Serial Number    field. Click on the OK    button after entering the product serial number and 
your (or your company's) name. Once you have entered this number, you will not be presented with this 
screen or with other registration reminders.



Status Bar

The Status Bar    may be enabled or disabled using the Options/Show Status Bar function. The Status 
Bar lies at the bottom of the main viewer, and shows the current cursor position (line number:column 
number), the number of lines in the file, and the size of the file (in bytes). If an image is being viewed, the 
size of the image in pixels is also displayed. If a media file is being viewed, the bar displays its length. 
And if an archived (ZIP/Lzh) file is being viewed, the number of files contained in the archived file is 
shown.



Window: Cascade

When this option is enabled, files being viewed will be placed into overlapping windows.



Window: Tile Vertical

When this option is enabled, each file being viewed will be placed into a window which runs from the top 
of the screen to the bottom. Multiple windows will be arranged side by side.



File Information

This dialog displays information about the currently selected file. At the top of the dialog, the file's Name    
is shown, followed by the Location    drive and directory where the file is stored.

If known, the Type    field will display the kind of data represented by this file. The Association    field will 
display the program which produced, edits or is otherwise associated with the file. Associations may be 
created or changed using the Windows File Manager (Explorer in Windows 95). See your Windows 
documentations for further details.

The Size    field shows the amount of storage space occupied by the file. The Last Modified    field shows 
the computer's date and time stamp produced when the file was created or stored after editing. The 
Attributes    field displays any file attributes (such as Archive, System or Hidden) attached to the file.

Press the OK  button to return to the main viewer.



Set Preferences Font Selector
When you select Set Font    from the Set Preferences dialog, you may select from the Windows fonts 
installed on your system.

Use the Font  selector to choose the typeface. The Font Style    field contains the available styles (Italic, 
Bold, etc.). and the Size    field lets you choose from a list of available sizes.

The Sample    box shows a preview of the font, style and size selected. Click on the OK    button to use 
the selected font, or choose the Cancel    button to return to the Set Preferences    dialog without changing 
the font.



Window: Tile Horizontal

When this option is enabled, each file being viewed will be placed into a window which runs across the 
screen from left to right. Multiple windows will be placed one above the other.



Find Next

Use this function to continue to search for text previously located using the Find    function. You may also 
use the F3    key or the Next    icon to continue searching.



Edit File

This function allows you to edit the the currently selected file. To edit a file using a text editor, you must 
have previously set up an editor using the Set Preferences/Miscellaneous section of the Options menu. 
To edit a file (such as some image and sound files) which Windows has been set up to recognize as 
being generated by a particular program, choose Use associated application.



File: Open

This command allows you to select a file to view.



File: Close

This function removes the currently selected file viewing window from the main viewing area. You may 
also close a file viewing window by using the button on the left side of its title bar.



File: Close All

This function clears the main viewing area of all files being viewed.



File: Exit

This command exits from the NeoSoft Viewer program and returns you to Windows.



Edit: Copy

The Copy    command allows you to place the currently selected material onto the Clipboard, or to write 
the material to the disk as a File (for which you will be asked to provide a name).



Edit: Select All

This function selects everything within the file currently being viewed. Note: this function is not available in 
all viewing modes.



Edit: Show Clipboard

Selecting this option causes the Windows Clipboard to be displayed, containing the last item(s) placed on 
the Clipboard using the Edit/Copy    command.



Main Viewing Area

The Main Viewing Area    occupies the large area between the icon/button bar and the status bar. Files 
which are being viewed are displayed in individual windows within this area. Each file viewing window 
contains tabs at the bottom of the window which allow viewing in either Standard or Hex mode, or 
(depending on the type of file) Image, Archive or Media. Viewing windows may be arranged in several 
orientations using the options under the Window menu button.



Standard Mode View

Clicking on this tab (or pressing the F6 key) will show the file in normal, ASCII character mode.

Certain text, image, animation/video, archive/compressed and sound file formats may be viewed (or 
listened to) as they would appear in the program which was used to create them. When NeoSoft Viewer 
detects such a file, an Image or Media tab will appear under the viewing area.

Note that certain file types may be encrypted or stored in special file formats which cannot be viewed 
directly. You may wish to look at these type files using the Hex view.



Icon Bar

The Icon Bar lies at the top of the window, just below the title and menu selections. Icons represent 
frequently used functions from the menu, and can save you a few extra mouse clicks. Click on the icon to 
use the function. To show or hide the Icon Bar, use the Options menu.



View Hex

Clicking on this tab (or pressing the F7 key) will cause the file to be displayed in Hex mode.

Certain text, image, animation/video, archive/compressed and sound file formats may be viewed (or 
listened to) as they would appear in the program which was used to create them. When NeoSoft Viewer 
detects such a file, an Image or Media tab will appear under the viewing area. Clicking on the Standard 
tab shows the file in normal character mode.



Option Show Button Bar

If you would like more area to view your files, you may use this function to remove the icon button bar 
from the interface.



Option Show Status Bar

If you would like more area to view your files, you may use this function to remove the Status Bar from the 
interface.



Option Expand Tabs

This option will display text files with tab characters replaced by the number of spaces which you have 
specified under the Options/Preferences function.



Window: Arrange Icons

When resizing the viewer screen, or when dragging individual viewer windows, it is possible that some 
windows may go off the screen completely, or that the views become jumbled one on top of another. Click 
on this function to reorder the file views.



Hex Filter Option

Enabling the Hex Filter option will suppress the display of extraneous characters in the ASCII display 
column on the right side of the Hex viewing window.



Help: How to use the Help System

When you click on a Help button    while performing a function, you will be presented with information on 
the purpose of the function and/or how to use it.

You may use the mouse to click on words appearing in [color and underlined] to bring up additional 
explanations or related topics.

Alternatively, you may enter the Help system from the Help    menu button at the top of the NeoSoft 
Viewer screen. This will address more general topics.

Once the Help Window appears, you may simply read the message, or use the buttons near the top of 
the window to explore further. If you wish to close the Help window, use the File/Exit function, or the 
button at the top/left corner of the window.

The Contents    button takes you to the opening Help screen, from which you may select further 
topics.

The Search    button brings up a window which allows you to select from key words contained in the 
Help file.

The Back    button takes you to the last screen viewed, while the History button lists the topics which 
you've explored thus far (click on a listed topic to return to it).

The Glossary    button displays definitions of uncommon words found in the Help system.

When there are additional topics related to the current Help screen, the << and >> buttons allow you 
to page back and forth between the previous and next pages.



Help Topic Search

This Help Menu function brings up the Search    function of the Help system in a separate window.



Window Refresh/Refresh All

Using these functions will check the file date/time stamp to see if it has been modified since it was loaded 
into the viewer. If the file has been modified and you choose either of these options, the modified file will 
be reloaded into the viewer to update the information being displayed.



Help/About

Selecting this function displays information about the NeoSoft Viewer and how to contact NeoSoft Corp. 
about updates and technical support. If you are running a 30-day evaluation version of the program, you 
will also be presented with a reminder screen.



Menu Commands

At the top of the main viewing screen are a list of drop-down menus. Select any of the topics listed below 
for more information on how to use the commands in these menus.

FILE Button

¤        Open

¤        Close

¤        Close All

¤        Information

¤        Edit File

¤        Run    ...

¤        Compare

¤        Print

¤        Exit

EDIT Button

¤        Copy

¤        Select All

¤        Show Clipboard

SEARCH Button

¤        Find

¤        Find Next
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File Run    ...

When an EXE, COM, BAT or PIF program file is currently selected in the viewer, you may use this 
function to launch that application.

Note that if another type of file is currently selected, this function will not appear in the menu.



File Compare

When you have at least two files loaded into the viewer, you may choose this option to have NeoSoft 
Viewer search the contents of the files for differences. E.g., If you found two files on your disks having the 
same names, you could use Compare    to see if one was a duplicate prior to deleting the file.



View Image, Archive or Media

Clicking on this tab (or pressing the F8 key) will display certain text, image, animation/video and sound 
files as they are viewed (or played) in the programs used to create them. Note that this tab will only 
appear under the viewing area when such a file is detected, and when this feature has been enabled 
using the Set Preferences function.

Files which have been archived in ZIP or Lzh format will display the names of the original file or files 
which are contained in the archive file. If you wish to view the contents of a file contained within an 
archive file, click on the filename and choose the View    button. The file will then be decompressed and 
displayed in the viewing area. If you wish to save the decompressed file to your disk, select the Extract 
to ...    button.

Note that certain file types may be encrypted or stored in special file formats which cannot be viewed 
directly. You may wish to look at these type files using the Hex view. The Standard tab displays the file in 
character mode. Note that ZIP format files which have been encrypted with a password cannot be viewed 
or extracted.



Purchasing NeoSoft Viewer

NeoSoft Viewer may be purchased from the dealers listed in the file DEALER.DOC, which is included with 
this program, and from other dealers worldwide. If you cannot find a dealer in your area which carries 
NeoSoft Viewer, you may print a copy of the order form and purchase the program directly from NeoSoft 
Corp.

NeoSoft may be contacted at:

NeoSoft Corp.
354    NE    GREENWOOD    AVE    SUITE      108
BEND    OR      97701-4631
USA

telephone:    503-389-5489
fax:    503-388-8221
BBS:    503-383-7195
E-mail:    sales@neosoftware.com
WWW site:    http://www.neosoftware.com/~neosft/
CompuServe:    type "GO NEOSOFT" at any "!" prompt

If you have networked systems or would like to purchase NeoSoft Viewer for multiple systems residing at 
the same location, you may purchase a network/site license for multiple systems at significant savings. 
Educational institutions are also entitled to an additional 10% discount on quantity purchases.

NeoSoft Corp. accepts payment by check or money order (drawn in U.S. dollar funds on a U.S. bank), 
VISA, MasterCard, Discover or American Express.



NeoSoft Viewer Order Form

To order NeoSoft Viewer 1.0, please complete the following form and:

Mail it to: NeoSoft Corp.
354 NE GREENWOOD AVE SUITE 108
BEND OR    97701-4631
USA

Fax it to: 503-388-8221 (24 hrs.)
or call: 503-389-5489 (weekdays 8:00-5:00 Pacific Standard Time)

----------------------------------------------------------------------------------------------------------------------------------
1. Enter your name, shipping address and telephone number below:

Name: ___________________________________________________

Company: ___________________________________________________

Address: ___________________________________________________

: ___________________________________________________

City: __________________ State:    __________ Zip: ___________

Country: ___________________________________________________

Telephone: ___________________________________________________
        I heard about NeoSoft Viewer from:      ________________________________

2. Indicate the number of units and shipping method below:

___    NeoSoft Viewer for Windows (one user) @ $19.95 each $__________
___    5 User Site License* @ $69.00 $__________
+ shipping:

United States: $5 US Mail, $9 FedEx
Canada/Mexico: $7 Air Mail, $10 UPS, $17 FedEx
Other Nations: $12 Air Mail, $19 FedEx $__________

                  (Note that FedEx/UPS cannot deliver to PO Boxes)
=========

TOTAL $__________
* please call NeoSoft Corp. for pricing on other quantities

3. Indicate the payment method below:

___    I've enclosed a check or money order payable to NeoSoft Corp.
(checks must be drawn in U.S. funds on a U.S. bank)

___    VISA                ___    MasterCard                ___    Discover                ___    American Express

Card number: _______________________      Expiration date:    _______

Cardholder's signature: _______________________________________



Preferences Directories

You may use the first field on this page to specify a directory into which the viewer will temporarily store 
information. Click on the arrow button on the right side of the field to browse through your directories. If 
you wish temporary information to be stored into the directory which DOS and Windows are already set 
up to use, simply enable the Use DOS' Temp Directory    box.

You may also select a text editor to use when the Edit File    function is chosen from the File menu. Use 
the arrow button at the right of this field to select an editor from the programs installed on your system.

If you wish to set other preferences (Font/Colors or Miscellaneous settings), click on the corresponding 
tabs at the bottom of the dialog. Use the OK    button to begin using the changes you have made, or use 
the Cancel    button to return to the main viewer without changing anything.






